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AIMS AND INFORMATION 

Objectives 

 Set up an EndNote online account. 

 Sync an EndNote Desktop library with EndNote Online. 

 Reset sync (deleting EndNote Online library) 

 Share an EndNote Desktop library 

 Share references in an EndNote Online library 

 Stop sharing a library or references 

 Use Word to work with your EndNote Online library 

 Documents in Dropbox or Google Docs 

Compatibility 

These notes are for Mac and PC users using EndNote X8 or higher. 

Note Conventions 

Navigation instructions are depicted with arrows: 

 Insert  Illustrations  Pictures  

 (Press Insert tab. In Illustrations group, press Pictures icon.) 

Previous Experience 

EndNote – For Research and Writing course or competent user 

Related Courses 

 EndNote – For Research and Writing 

Further Information 

 otago.ac.nz/it-training 

 blogs.otago.ac.nz/endnote 
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ENDNOTE DESKTOP V ENDNOTE ONLINE 

In EndNote, you use a library on your machine, which is referred to as 

the desktop library. It is best practice to only have one library. 

You can make a back-up by compressing (zipping up) a library and 

storing it somewhere. Or you can also create an EndNote Online 

account and sync your library there.  

This would mean that you could access your library from any 

computer: Mac, PC or iPad.  

If you have the EndNote Desktop version installed on multiple 

computers (or iPad), you can log into the EndNote Online site and 

sync  to copy your library onto that machine. Then, as you work, you 

can sync the copy in front of you with the copy on EndNote Online. 

You can also login to EndNote Online to work with your library there. 

Any changes made there could be synced later when you return to 

the desktop version. 

EndNote Licenses 

EndNote Desktop 

Once you acquire a copy of EndNote Desktop (as a student or staff 

member), you are entitled to every new updated version.  

This does not happen automatically, so you will have to get in touch 

with AskOtago to get the latest version. 

EndNote Online (or EndNote Web) 

The full EndNote Online features last for two years after activation of 

EndNote Desktop. After the two year period, if you sync from a new 

version of EndNote Desktop, you’ll get another two years of full 

functionality. As long as you are a student or staff member, you 

always have access to the latest version of EndNote Desktop.  

If you don’t have a new version of EndNote Desktop to sync two years 

later, you still have EndNote Online (which is free), but you can no 

longer sync it with EndNote Desktop. 
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ENDNOTE ONLINE 

EndNote Online is a web-based account you can use to just backup 

your library, or work with it there. It also makes it possible for you to 

share your library (or just individual folders) with up to 100 people. 

NOTE: You can only sync one EndNote Desktop library with EndNote 

Online. Before beginning, ensure that you are in the library you would 

like to associate with your account. If you sync more than one, they 

will be merged. 

Sign up for an EndNote Online account 

To get an EndNote Online account, open EndNote on your computer.  

PC users: In the Edit menu, go to Preferences at the very bottom and 

then select the Sync category. 

Mac users: In the EndNote X8 menu, go to go to Preferences,  and 

then select the Sync category. 

 

Press the Enable Sync button toward the top of the window. 

If you do not have an account already, press the Sign Up button. 

(Otherwise, you could fill in your email address and password now.) 
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In the following screen, type in your email address twice and press 

Submit. 

 

Then fill in the User Registration form, setting a password, and agree 

to the terms and conditions. 
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Then press Done. 

 

Back in the Sync window, your details will be filled in.  

Press Enable Sync again to switch it on. 
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Your details should appear in that window as well. Press OK. 

 

Your account is now set up.  
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SYNC ENDNOTE DESKTOP AND ENDNOTE ONLINE 

Before syncing for the first time, it is recommended that you make a 

back-up of your library, by going to the File menu, selecting 

Compressed Library, and saving a copy. 

 

Notice the Sync Automatically option. The Sync process works 

automatically in the background (every 15 minutes) when you select 

this. It also means your libraries will sync when you open and close 

EndNote Desktop. 

 

When you close EndNote, the system will prompt you to sync your 

EndNote Desktop library with your EndNote Online library. 

For ad hoc syncing, use the Sync button any time you want to save 

changes (towards the right end of the toolbar), or go to the Tools 

menu and select Sync. 

 

Syncing progress is indicated by a green status bar in the bottom 

right corner of the library. 
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RESET SYNC (DELETE ENDNOTE ONLINE LIBRARY) 

Automatically syncing your EndNote Desktop library with EndNote 

Online is a great way to keep a cloud-based back-up of your library, 

as well as being the way to share your library (or individual library 

groups) with up to 100 people. 

However, sometimes this syncing can go wrong, and it can be quite 

difficult to get it back on track. So one option is to completely erase 

what is in EndNote Online and reset it with a new sync of 

your EndNote Desktop library. 

To do that, follow these steps: 

Open EndNote Desktop on your computer. Make a back-up of your 

library by going to File –>Compressed Library, and saving the whole 

thing, including file attachments. 

 

PC users: click on Edit  Preferences  Sync.  

Mac users: click on EndNote X8  Preferences  Sync. 

Untick Sync Automatically and then restart EndNote.  

 

The trash must be empty, so if there is anything there, right-click on 

the Trash and choose Empty Trash. 

https://blogs.otago.ac.nz/endnote/files/2018/05/EN-Comressed-library.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-NOT-syncing-automatically.png
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Open EndNote Online:  http://www.myendnoteweb.com . You will 

need to delete all references, trash, and groups from here. 

To delete all references, first go to My References. 

 

Then click on All My References, tick the All box and press 

the Delete button. If you have a large library, this will delete all the 

references in the library, including any not not listed on this page. 

(You would get a confirmation of this where you could click OK.) 

 

Once they have all been deleted, you will need to empty the Trash. To 

do this, press the Empty button beside the Trash. 

 

To delete any groups, go to the Organize tab and click on Manage My 

Groups. 

 

Then press the Delete button to the right of each group, and 

press OK to confirm for each one in turn. 

http://www.myendnoteweb.com/
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-Empty-trash.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-online-my-references.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-online-Delete-all-references.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-online-Empty-trash.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-Manage-my-groups.png
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If you have shared a group, you may want to first open Manage 

Sharing so you can keep track of who you shared it with and be ready 

to re-share it when it is reinstated. Press Delete All to remove 

everyone, and then go back to the main screen. 

 

Go back to All My References and check that that you have no 

references, trash or groups. 

 

Back in EndNote Desktop,  

PC users: click on Edit  Preferences  Sync.  

Mac users: click on EndNote X8  Preferences  Sync. 

https://blogs.otago.ac.nz/endnote/files/2018/05/EN-online-delete-all-groups.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-online-remove-shared-groups.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-online-no-references-trash-or-groups.png
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Add this to the end of your email address in the sync 

preferences: #!resetLocalSync 

( Note! This is case-sensitive. It is not #!resetlocalsync, 

but #!resetLocalSync ) 

 

Click OK to close the preferences. 

Then click the Sync button on the toolbar. 

PC:  Mac:  

EndNote will appear to authenticate and return the prompt: “A Sync 

library can be linked to only one account. Do not proceed unless you 

intend to break the link to the original account.” Click OK. 

Another message now appears: “Your local sync state has been reset. 

Please re-enter your E-Mail Address, restart EndNote, and sync 

again.” Click OK. 

Close EndNote Desktop and open it again. Make sure you are in the 

library you want to sync with EndNote Online. 

  

https://blogs.otago.ac.nz/endnote/files/2018/05/EN-resetLocalSync.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-Manual-sync-button.png
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PC users: return to Edit  Preferences  Sync.  

Mac users: return to EndNote X8  Preferences  Sync. 

Remove the wording about local syncing from the end of your email 

address. Ensure you just have your normal email there now (and 

password), and tick the box to Sync Automatically. Click OK. 

 

Click the Sync button on the toolbar. You will once again get “A Sync 

library can be linked to only one account. Do not proceed unless you 

intend to break the link to the original account.” Click OK. 

You will be prompted to make a backup. If you have not done so 

already, you should create a compressed back-up copy of your 

library. If you already have done so, you can click No. 

A complete, new sync will then begin, using your EndNote 

Desktop library as the source. Note that, depending on the size of 

your library and number of PDFs, this may take some time. 

PC users can check progress in the bottom right corner of the screen:

 

Mac users see this in the top centre of the screen: 

 

When it finishes, return to EndNote Online and confirm your library is 

copied there. 

https://blogs.otago.ac.nz/endnote/files/2018/05/EN-normal-email-and-YES-to-sync-Automtically.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-syncing.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-syncing-progress-on-Mac.png
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SHARE YOUR LIBRARY  

Note that although you can only share your library with 100 people, 

you can have unlimited libraries shared with you. 

Sharing EndNote Desktop library 

When you share your EndNote Desktop library, the other users get 

full read-write access to your live library (including PDFs), which they 

can open in their own copy of EndNote Desktop. However, they must 

also have at least EndNote X8+ as well. 

To share your desktop library so another person can open and edit it 

with their own copy of EndNote X8 or higher, go to the toolbar and 

press the Share button. Alternatively, you can go to File  Share. 

PC users: 

 

Mac users: 

 

In the Sharing window, you can add up to 100 people. Write in the 

email address and an optional message to invite someone to share 

your library. 
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You can keep track of the status of this person in the window. You 

can also use the cog beside their name to stop sharing the library 

(Remove) or to send the email invitation again (Remind). 

 

The other person will get an email. They need to press the Accept 

button. 



14 

 

 

This takes them to EndNote.com where they have to sign in or create 

an account, and then Accept. 

 

Once they have logged in and accepted the invite on EndNote.com, 

they get a confirmation that they can now access the library, if they 

are using EndNote X7 or higher. If they aren’t on the right version, 

instructions are included on this screen to help them upgrade. 
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Back in EndNote on their computer, they would go to the File menu, 

and select Open Shared Library. 

 

They must then login to EndNote Online if they haven’t already done 

so. 

 

Once logged in, they choose the email address of the person who 

shared the library with them. (They can have an unlimited number of 

libraries shared with them.) Then they press Open. 
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This opens your library on their machine.  
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They can now make changes to that library, (which includes dragging 

and dropping references between to copy them). 

If they attempt to close the library without syncing the changes, they 

will be prompted to do so. 

 

Syncing progress:. 

PC users can check progress in the bottom right corner of the screen: 

 

Mac users see this in the top centre of the screen: 

 

Any changes they have made will be visible to you as soon as you 

sync your library as well. 

  

https://blogs.otago.ac.nz/endnote/files/2018/05/EN-syncing.png
https://blogs.otago.ac.nz/endnote/files/2018/05/EN-syncing-progress-on-Mac.png
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Remove sharing privileges 

To stop sharing your library with this person, return to the File menu, 

and select Share. Press the cog beside their name and select 

Remove. 

 

They will receive an email telling them this has happened. 

 

If they happen to have the library open, it looks like they can still edit 

it, but the changes will not be synced.  

Once they close it, they cannot open it again. 
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SHARING ENDNOTE ONLINE REFERENCES 

When you share a copy of your library via EndNote Online, there are 

several differences. 

 The other person does not have to have EndNote Desktop, 

but they do need an EndNote Online account (which is free). 

If they do not have this when you share with them, they will 

be prompted to set one up. 

 The other person cannot open your library in EndNote 

Desktop, only in EndNote Online. However, they will be able 

to copy your references to their own EndNote Online library, 

and then even sync them with their own EndNote Desktop (if 

they have that). 

 You share groups, not a whole library. (However, there is 

nothing to stop you from granting access to all your groups.) 

 You determine if they get read-only or full read-write access. 

 The other person does not get access to any of your PDFs.  

Set up sharing in EndNote Online 

Once you have created an EndNote Online account and synced your 

desktop library to it, you can access your library online via 

www.myendnoteweb.com .  To share your online library with others, 

go to that website and sign in. 

 

On the Organize tab, choose Manage my groups. (If you don’t have 

any groups yet, you can create some here.) 

 

http://www.myendnoteweb.com/
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Create a new group of references 

In the Manage My Groups page, press the New Group button. 

 

In the pop-up window, give it a name, and press OK. 

 

To add references to it, press My References in the toolbar. Then put 

a tick beside selected references and use the Add to group drop-

down at the top of the page to add them to the group. 

Note: you can also create more groups as you go by clicking on New 

group and making one for your references to go into. 
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Delete a group 

Go to Organize  Manage My Groups, find the group you’d like to 

delete and press the Delete button. In the pop-up confirmation 

window, press OK. 

 

Share a group of references 

Note: The people you share with do not need to have EndNote 

Desktop. They need EndNote Online, but they will be prompted to 

create an account if they don’t have one already. 

In the Manage My Groups page, find the group you’d like to share 

and press the blue Manage Sharing button. 

 

In the next window, press Start sharing this group. 
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Type in someone’s email address, or use Choose File to upload a text 

file with multiple email addresses, separated by commas.  

Then select whether this will be Read only or Read & Write, and press 

Apply. 

 

Read only allows them to view your references, copy them into their 

own EndNote Web library, or use them in Microsoft Word, but they 

cannot edit or delete them. 

Read & Write lets them view your references, copy them into their 

own EndNote Web library, or use them in Microsoft Word, and it will 

also allow them to edit them, add new ones, and delete any of them. 

Changes made to your references by others with Read & Write 

access will also be synchronized back to your EndNote Desktop 

library if you are synchronizing your libraries. 

NOTE: Remember that PDFs cannot be shared, regardless of access.  

It confirms the email address was added. Close the window. 
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Back in the main website window, you can see the email added. You 

can change their editing rights, or remove them entirely from here.  

NOTE: You cannot see if someone has editing privileges until you 

open this. 

 

Click back on Manage My Groups at the top to return to the list.  

There should now be a tick in the Share box and some people 

displayed beside the group name. If there is no tick, add one. Without 

that, it is not fully shared with the other people. 
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What the other person sees 

When the person you’ve shared a group with has been added, they 

do not receive any email notification, but they will see your group(s) 

listed below their own in their EndNote online library.  

If they see an outline of people beside the group name, this means 

they can edit the references. 

 

If they go to the Organize tab and choose Others’ Groups, they can 

choose whether or not so display your group, as well as choose if 

they want to use it with Word.  

 

They can also see the email address of the person shared this group 

with them. If they see an outline of people in the Access column, this 

means they can edit the references. 

 

If you stop sharing a group, the other person does not receive any 

notification. The group simply disappears off their list. 
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WORD WITH ENDNOTE ONLINE  

Normally when you use the Cite While You Write feature in Word, it 

will pick up your references from EndNote Desktop.  

The EndNote Desktop version is usually the far better choice for this. 

However, if you’d prefer to use EndNote Online, you can change the 

settings in Word to get references directly from your EndNote Online 

library instead of the desktop one. 

In Word, press the EndNote X8 tab. Then at the far right, choose the 

Preferences button in the Tools group. 

 

Then find the Application tab. Change the Application setting here 

from EndNote to EndNote online. Then you must fill in your email 

address and password to complete the process.  

Press OK when finished. 
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WORD DOCUMENTS 

If you want to write a document with other people, it can be done in a 

variety of ways, but generally speaking, it is best to edit the document 

in Word as it has the Cite While You Write automatic connection to 

EndNote Desktop or EndNote Online. 

In-text Citations 

EndNote works with Word to allow users to add in-text citations and 

automatically build a bibliography. To begin, you place your cursor 

where you would like to insert a citation in your document. If you are 

using a footnote style, you must first create the footnote (see below). 

Insert selected citations in-text 

Click where you would like the citation to go in your text. Then select 

a citation (or multiple ones) from inside EndNote and put it in your 

document.  

To insert it directly from EndNote, click the Insert Citation button in 

the EndNote toolbar.  (Keyboard shortcut: Alt + 2.) 

 

Alternatively, to insert the citation from Word ,  

PC users: go to EndNote X8  (bottom half of) Insert Citation button 

 Insert Selected Citation(s). 

 

Mac users: go to arrow beside EndNote X8  Insert Selected 

Citation(s). 
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Inserting Citations into Footnotes 

Styles requiring footnotes will only allow in-text citations within 

footnotes. These styles include Chicago A and MLA. 

To do this, create a footnote first in Word (References  Insert 

Footnote). With the cursor in the footnote reference area at the 

bottom of the page, insert the citation from EndNote as above. 

Other ways to insert in-text citations / bibliography 

entries 

You can also just copy and paste references into your document. In 

EndNote, select a reference (or multiple references). Then right-click 

and choose Copy to get the in-text citation. Then paste it into the 

document. 

To only add a reference to the bibliography (not the document), use 

Copy Formatted and paste it in the bibliography. 

Set citation style 

Ensure that the output style is correct. In Word, go to the EndNote X8 

tab on the ribbon. In the Bibliography group, find the Style drop-

down list. This should be the same as the one in EndNote. Select the 

correct style here.  

If you do not see it, refer to the EndNote for Research and Writing 

course for options. 
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Editing or deleting citations 

Go EndNote X8  Edit & Manage Citation(s). Follow instructions 

below, depending on the text to add, and style used.  Note that 

EndNote knows which library your references came from. 

 

Edit a reference 

Formatting: Default can be changed to exclude elements, or remove 

the entire in-text reference, and only include it in bibliography. 

 

Prefix: text to insert before the in-text citation, but kept within the 

brackets. 

Suffix: text to insert after the in-text citation, but kept within the 

brackets. 

Pages: If you want to include page numbers for a quote, and your 

style allows them, add them here. Do not include any letters. Your 

style should take care of that.  
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If your style does NOT allow page numbers (Harvard), use the Suffix 

field instead, adding letters as necessary. 

        

Delete a reference  

Click on the cog to the right of the reference and select Remove 

citation.  
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FORMAT BIBLIOGRAPHY 

Format Bibliography 

When EndNote creates the bibliography at the end of your 

document, it tends to just be single-spaced. You need to make the 

paragraph formatting match your document. 

PC users: go to EndNote X8 tab, and click on the arrow in the bottom 

right corner of the Bibliography group. 

 

Mac users: go to EndNote X8 tab, press Bibliography and select 

Update Citations and Bibliography. 

 

In the window, choose the Layout tab. Notice the Line spacing and 

Space after settings in the bottom right corner.  
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Change the line spacing to 1.5 or Double depending on how you have 

set up your document paragraphs.   

Do the same for the space after. 
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REMOVE ENDNOTE FIELD CODES 

When EndNote is working with Microsoft Word, it adds hidden 

information, called Field Codes, behind the formatted citations.  

These can cause issues with publishing software, so many journals 

request that you do not have EndNote field codes in your document. 

To remove these, in Word… 

PC users: go to the EndNote X8 tab, Bibliography group. Press 

Convert Citations and Bibliography  Convert to Plain Text.  

 

Mac users: go to the EndNote X8 tab, and press Tools. Then select 

Convert to Plain Text. 

 

This will create a new copy of the document, which EndNote cannot 

update. All the formatting is in place, but all citations have been 

changed to normal text.  
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COLLABORATING - THE TRAVELING LIBRARY 

If you are collaborating with others on a Word document, keep all the 

citations formatted. This means they are in their final state, and the 

bibliography is visible at the end of the document. 

When you share it with someone and they edit it adding their own 

citations, Word will store them all an internal library within the 

document. 

To see how the references are tracked, go to the EndNote X8 tab, 

and towards the left, press Edit & Manage Citations. 

 

In this window, the library column shows all references and identifies 

the library they came from. Any references added by other people 

are in the Traveling Library. 

 

If you would like to add any of these to your own library,  
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PC users: go to the EndNote X8 tab, and at the right end, choose 

Export to EndNote, and choose Export Traveling Library. 

 

Mac users:  go to the EndNote X8 tab, and press Tools. Then select 

Export Traveling Library. 

 

Choose whether to add this to your existing library, or to create a 

new library with all the references in the document.  

If you choose to add them to an existing library, only the new 

references will be added. You will not be duplicating your own. 

ONLINE DOCUMENT STORAGE PROGRAMMES 

Dropbox 

If you store a document on Dropbox, it is recommended that you still 

open it in the full version of Word to add/edit references.  

If you do want to work with it online, co-authoring is supported in 

Word Online in Dropbox, but it does not include the ability to add 

EndNote citations. 

Google Docs 

There is documentation online showing how to use this, but for best 

results, it is still recommended that you download documents into 

the full desktop version of Word for adding/editing EndNote citations. 


